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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP ProBook 6360b Notebook PC

Processors

Intel® Core™ i7 processor, Dual Core
2nd Generation Intel Core i7-2620M, 2.70GHz (Turbo up to 3.40GHz) 4MB
L3 Cache, 4 threads
Intel Core i5 processors, Dual Core
2nd Generation Intel Core i5-2540M, 2.60-GHz (Turbo up to 3.30)
processor 3-MB L3 cache, 4 threads
2nd Generation Intel Core i5-2520M, 2.50-GHz (Turbo up to 3.20)
processor 3-MB L3 cache, 4 threads
2nd Generation Intel Core i5-2410M, 2.30-GHz (Turbo up to 2.90)
processor 3-MB L3 cache, 4 threads
Intel Core i3 processors, Dual Core
Intel Core i3-2330M, 2.20-GHz processor 3-MB L3 cache, 4 threads
Intel Core i3-2310M, 2.10-GHz processor 3-MB L3 cache, 4 threads
Intel Celeron processor
Celeron B810, 1.60GHz, 2MB L3 Cache, 2 threads

Chipset

vPro: Mobile Intel QM67 chipset
Non-vPro: Mobile Intel HM65 chipset

Graphics

UMA: Intel HD Graphics 3000
UMA/Celeron: Intel HD Graphics

Panel

All display assemblies include 2 wireless local area network (WLAN)
antennas. All WWAN display assemblies include 2 wireless wide area
network (WWAN) antennas as well.
33.8-cm (13.3-in) HD AntiGlare LED SVA (1366x768)
33.8-cm (13.3-in) HD AntiGlare LED SVA (1366x768) WWAN
33.8-cm (13.3-in) HD AntiGlare LED SVA (1366x768) with webcam
33.8-cm (13.3-in) HD AntiGlare LED SVA (1366x768) WWAN with
webcam
Support privacy filter

1

Category

Description

Memory

Two customer-accessible/upgradeable memory module slots supporting
up to 16 GB of RAM
Supports dual-channel memory
PC3-10600, 1333-MHz, DDR3
Supports the following configurations:

Hard drives

●

16384 (8192 × 2) — Qual Only

●

8192 (4096 × 2)

●

8192 (8192 × 1)

●

6144 (4096 × 1) + (2048 x 1)

●

4096 (2048 × 2)

●

4096 (4096 × 1)

●

3072 (2048 × 1) + (1024 x 1)

●

2048 (2048 × 1)

Supports 7mm or 9.5mm, 6.35cm (2.5”) SATA hard drives
Supports 2.5” solid-state drives (SSDs)
Customer-accessible
Supports the following drives:
●

750-GB, 7200-rpm

●

500-GB, 7200-rpm

●

320-GB, 7200-rpm

●

320-GB, 7200-rpm Self Encrypting Drive (SED)

●

250-GB, 7200-rpm

Supports the following solid-state drives:
●

160-GB

●

128-GB

HP Mobile Data Protection System 3D
Upgrade bay

Fixed (removal of 1 screw required)
Customer-accessible
Serial ATA
12.7-mm tray load
Supports “No Drive” option (weight saver)
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Category

Description
Supports the following 12.7-mm SATA optical drives:
●

DVD±RW SuperMulti DL LightScribe Drive

●

Blu-ray ROM DVD±RW SuperMulti DL LightScribe Drive

●

DVD-ROM Drive

Supports the following 9.5-mm SATA hard drive:
●
Microphone

320-GB, 7200-rpm

Webcam: Integrated dual-array microphone
Non-Webcam: Integrated mono microphone

Audio

HD audio
Stereo speakers. Produce SRS Premium Sound.

Webcam

Integrated 720p HD webcam

Modem

56K V.92 MDC data/fax modem
Modem cable not included
Supports “No Modem” option

Ethernet

vPro: Intel 82579LM GbE LAN 10/100/1000 network interface card (NIC)
with iAMT
Non-vPro: Intel 82579V GbE LAN 10/100/1000 network interface card
(NIC)
S3/S4/S5 wake on LAN
NIC power down technology
Ethernet cable not included

Wireless

Integrated WLAN options by way of wireless module:
Two WLAN antennas built into display assembly
Supports “no WLAN” option
Supports the following WLAN formats:
●

Intel Wi-Fi Link 6205, 802.11a/b/g/n, 2 × 2

●

Intel Wi-Fi Link 1000, 802.11b/g/n 1 x 2

●

Broadcom 4322 802.11a/b/g/n, 2 × 2

●

Broadcom 4313 802.11b/g/n 1 x 1

Integrated WWAN options by way of wireless module:
Two WWAN antennas built into display assembly
GPS support
Subscriber identity module (SIM) security (customer-accessible in battery
bay)
Supports “no WWAN” option
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Category

Description
Supports the following WWAN modules:
●

Qualcomm Gobi 3000 HSPA/CDMA with GPS

●

Ericsson 5521 HSPA+ with GPS

Integrated personal area network (PAN) options by way of
Bluetooth® module:
Supports “no PAN” option
Broadcom Bluetooth
External media card

ExpressCard (54mm) slot
NOTE: This slot can be configured with either an ExpressCard or Smart
Card reader.
Integrated Media Card Reader with SD and MMC support

Ports

Audio-in (stereo microphone)
Audio-out (stereo headphone)
DisplayPort
RJ-11 (modem)
RJ-45 (Ethernet, includes link and activity lights)
USB 2.0 (3)
eSATA/USB 2.0 Combo
VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-GHz
(hot plug with auto-detect)
1394a
3-pin AC power
Docking connector

Docking

HP 90W Docking Station
HP 120W Advanced Docking Station

Keyboard/pointing devices

Full-size keyboard
Supports TouchPad only or dual point (pointing stick and TouchPad)
Spill-resistant design, HP DuraKeys
Three launch buttons (QuickWeb, WLAN on/off, and Mute)

Power requirements

AC adapter (65-W) with localized cable plug support (3-wire plug with
ground pin, supports 3-pin DC connector)
9-cell, 3.00-Ah (100-Wh) Li-ion battery
6-cell HP Long Life, 2.8-Ah (55-Wh) Li-ion battery
6-cell, 2.55-Ah (55-Wh) Li-ion battery
3-cell, 2.80-Ah (31-Wh) Li-ion battery
Supports ST09 Extended Life Notebook Battery
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Category

Description
Supports BB09 Ultra Extended Life Notebook Battery
Support for 6-cell, 2.80-Ah (62-Wh) battery
HP Fast Charge Technology (does NOT support 9-cell, 3.00-Ah (100-Wh)
Li-ion battery)

Security

Integrated fingerprint reader
Integrated Smart Card reader slot
NOTE: This slot can be configured with either an ExpressCard or Smart
Card reader (optional).
Security cable slot
Trusted platform module (TPM) V.1.2
Full volume encryption
Preboot authentication (password, Smart Card)

Operating system

Preinstalled:
Windows 7 Professional 64 with MS Basics
Windows 7 Professional 32 with MS Basics
Windows 7 Home Premium 64 with MS Basics
Windows 7 Home Premium 32 with MS Basics
Windows Vista Basic 32 with MS Basics
Novell™: SuSE Linux™ Enterprise Desktop
FreeDOS
Preinstalled with Microsoft® Office:
Windows 7 Professional 64 with Microsoft Office 2010 Professional
Windows 7 Professional 64 with Microsoft Office 2010 Home & Business
Windows 7 Professional 64 with Microsoft Office 2010 Personal
Windows 7 Professional 64 with Microsoft Office 2010 pre-loaded
(purchase of a Product Key required to activate a full Office 2010 suite)
Windows 7 Professional 32 with Microsoft Office 2010 Professional
Windows 7 Professional 32 with Microsoft Office 2010 Home & Business
Windows 7 Professional 32 with Microsoft Office 2010 Personal
Windows 7 Professional 32 with Microsoft Office 2010 pre-loaded
(purchase of a Product Key required to activate a full Office 2010 suite)
Windows 7 Home Premium 64 with Microsoft Office 2010 Professional
Windows 7 Home Premium 64 with Microsoft Office 2010 Home &
Business
Windows 7 Home Premium 64 with Microsoft Office 2010 Personal
Windows 7 Home Premium 64 with Microsoft Office 2010 pre-loaded
(purchase of a Product Key required to activate a full Office 2010 suite)
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Category

Description
Windows 7 Home Premium 32 with Microsoft Office 2010 Professional
Windows 7 Home Premium 32 with Microsoft Office 2010 Home &
Business
Windows 7 Home Premium 32 with Microsoft Office 2010 Personal
Windows 7 Home Premium 32 with Microsoft Office 2010 pre-loaded
(purchase of a Product Key required to activate a full Office 2010 suite)
Windows 7 Home Basic 32 with Microsoft Office 2010 pre-loaded
(purchase of a Product Key required to activate a full Office 2010 suite)
Windows 7 Starter 32 with Microsoft Office 2010 pre-loaded (purchase of a
Product Key required to activate a full Office 2010 suite)
Windows Vista Home Basic with Microsoft Office 2010 Professional
Windows Vista Home Basic with Microsoft Office 2010 Home & Business
Windows Vista Home Basic with Microsoft Office 2010 Personal
Windows Vista Home Basic with Microsoft Office 2010 pre-loaded
(purchase of a Product Key required to activate a full Office 2010 suite)
Restore Media:
Windows 7 Starter
Windows 7 Home Basic 32
Windows 7 Home Premium 32
Windows 7 Home Premium 64
Windows 7 Professional 32
Windows 7 Professional 64
Windows 7 DRDVD with WinDVD (Available with Windows 7 Home Basic
and Windows 7 Starter)
Windows 7 DRDVD without WinDVD (Available with Windows 7 Home
Premium and Windows 7 Professional)
Web-only support:
Windows XP Professional 32
Windows Vista 32/64 Enterprise
Windows Vista 32/64 Business
Windows 7 Enterprise 32/64 (SP1)
Windows 7 Ultimate 32/64 (SP1)
Certified:
Novell™: SuSE Linux™ Enterprise Desktop

Serviceability

Customer service replaceable parts:
AC adapter
Battery (system)

6

Chapter 1 Product description

Category

Description
Hard drive/SSD
Memory module
Optical drive
Mini-PCI components (WLAN, WWAN, Bluetooth, Flashcache, SIM)
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2

External component identification

Display

Component

Description

(1)

Turns off the display or initiates Sleep if the display is closed
while the power is on.

Internal display switch

NOTE: The display switch is not visible from the outside of the
computer.
(2)

WLAN antennas (2)*

Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3)

WWAN antennas (2)* (select models only)

Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(4)

Internal microphone(s) (1 or 2 depending on
model)

Record sound.

NOTE: Single microphone provided for nonwebcam models and dual microphones provided
for webcam models.
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Component

Description

(5)

Webcam light (select models only)

On: The webcam is in use.

(6)

Webcam (select models only)

Records video and captures still photographs.
To use the webcam, select Start > All Programs > HP >
HP Webcam.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Display
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Top components
Pointing devices (select models only)

Component

Description

(1)

Pointing stick

Moves the pointer and selects or activates items on the screen.

(2)

Left pointing stick button

Can be used with the pointing stick and functions like the left
button on an external mouse.

(3)

TouchPad on/off button

Turns the TouchPad on and off.

(4)

TouchPad

Moves the pointer and selects or activates items on the screen.
NOTE: Vertical scrolling is supported on the right edge of the
TouchPad.

(5)

Left TouchPad button

Functions like the left button on an external mouse.

(6)

Right pointing stick button

Can be used with the pointing stick and functions like the right
button on an external mouse.

(7)

Right TouchPad button

Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel >
Hardware and Sound > Mouse.
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Lights

Component

Description

(1)

●

Amber: The TouchPad is off.

●

Off: The TouchPad is on.

TouchPad on/off light

(2)

Caps lock light

On: Caps lock is on.

(3)

Power light*

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.

●

Amber: All wireless devices are off.

●

On: The computer is on.

●

Off: The computer is off or in Hibernation.

(4)

(5)

Wireless light†

QuickWeb light

NOTE: For more information, refer to “HP QuickWeb” in this
guide and to the HP Quickweb software Help
(6)

(7)

Mute light

Num lock light

●

Amber: Computer sound is off.

●

Off: Computer sound is on.

On: Num lock is on.

*The light on the power button is visible only when the computer is open. The power light on the front of the computer is
visible whether the computer is open or closed.
†
The light on the wireless button is visible only when the computer is open. The wireless light on the front of the computer is
visible whether the computer is open or closed.

Top components
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Buttons, switches, and fingerprint reader

Component

Description

(1)

TouchPad on/off button

Turns the TouchPad on and off.

(2)

Power button

●

When the computer is off, press the button to turn
on the computer.

●

When the computer is on, press the button briefly
to initiate Sleep.

●

When the computer is in the Sleep state, press the
button briefly to exit Sleep.

●

When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.
To learn more about your power settings:

(3)

12

Wireless button

Chapter 2 External component identification

●

Windows 7—Select Start > Control Panel >
System and Security > Power Options.

●

Windows Vista—Select Start > Control Panel >
System and Maintenance > Power Options

●

Or refer to the HP Notebook Reference Guide.

Turns the wireless feature on or off but does not
establish a wireless connection.

Component

Description

(4)

●

When the computer is off or in Hibernation, press
the button to open HP QuickWeb.

●

When the computer is in Microsoft Windows, press
the button to open the default Web browser.

●

When the computer is in HP QuickWeb, press the
button to open the default Web browser.

QuickWeb button

NOTE: For more information, refer to “HP QuickWeb”
in this guide and to the HP QuickWeb software Help. If
your computer does not have HP QuickWeb software,
the button does not perform any action or function.
(5)

Volume mute button

Mutes and restores speaker sound.

(6)

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a
password logon.

Top components
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Keys

14

Component

Description

(1)

esc key

Displays system information when pressed in combination with
the fn key.

(2)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

(3)

fn key

Turns the embedded numeric keypad on and off when pressed in
combination with the num lk key.

(4)

Windows logo key

Displays the Windows Start menu.

(5)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

(6)

Integrated numeric keypad keys

Can be used like the keys on an external numeric keypad.

(7)

num lk key

Turns the embedded numeric keypad on and off when pressed in
combination with the fn key.

Chapter 2 External component identification

Front components

Component

Description

(1)

Display release latch

Opens the computer.

(2)

Wireless light

●

An integrated wireless device, such as a WLAN device, the
HP Mobile Broadband Module (select models only), and/or
a Bluetooth device, is on.

●

Amber: All wireless devices are off.

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

Amber: A battery is charging.

●

Turquoise: A battery is close to full charge capacity.

●

Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

●

Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

●

Blinking turquoise: The hard drive or optical drive is being
accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(3)

(4)

(5)

(6)

Power light

Battery light

Drive light

Speakers (2)

Produce SRS Premium Sound.
NOTE: To use the SRS Premium Sound software, select Start
> All Programs > SRS Premium Sound.

(7)

Media Card Reader

Supports the following optional digital card formats:
●

MultiMediaCard

●

Secure Digital (SD) Memory Card

Front components
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Left-side components

Component

Description

(1)

Attaches an optional security cable to the computer.

Security cable slot

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.
(2)

RJ-45 (network) jack

Connects a network cable.

(3)

USB ports (2)

Connect optional USB devices.

(4)

ExpressCard slot

Supports optional ExpressCards.
NOTE: This slot can be configured with either an ExpressCard
or Smart Card reader.
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(5)

Upgrade bay

Supports an optical drive, secondary hard drive, or “No Drive”
option (weight saver).

(6)

Optical drive eject button (select models only)

Ejects the optical drive.

Chapter 2 External component identification

Rear components

The vent enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal components and prevent
overheating. It is normal for the internal fan to cycle on and off during routine operation.
Component

Description

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

Right-side components

Component

Description

(1)

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

Audio-out (headphone) jack

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.
(2)

Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(3)

1394 port

Connects an optional IEEE 1394 or 1394a device, such as a
camcorder.

(4)

eSATA/USB port

Connects high-performance eSATA components, such as an
eSATA external hard drive or connects an optional USB device.

(5)

USB port

Connect optional USB devices.

(6)

DisplayPort

Connects an optional digital display device, such as a highperformance monitor or projector.

(7)

External monitor port

Connects an external VGA monitor or projector.

(8)

RJ-11 (modem) jack

Connects a modem cable.

(9)

Power connector

Connects an AC adapter.

Rear components
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Bottom components

Component

Description

(1)

Battery release latch

Releases the battery from the battery bay.

(2)

Docking connector

Connects an optional docking device.

(3)

Bottom cover release latch

Releases or locks the bottom cover.

(4)

SIM slot

Contains a wireless subscriber identity module (SIM) (select
models only). The SIM slot is located inside the battery bay.

(5)

Battery bay

Holds the battery.

(6)

Accessory battery connector

Connects an optional accessory battery.

(7)

Wireless and memory module compartments
and hard drive bay

Hold an HP Mobile Broadband Module, the memory modules,
and the hard drive.
NOTE: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for use in
the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and
then receive a warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

(8)

Bluetooth compartment

Contains a Bluetooth device.

(9)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.
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Wireless antennas (select models only)
The antennas send and receive signals from one or more wireless devices. These antennas are not
visible from the outside of the computer.

Component

Description

(1)

WLAN antennas (2)*

Send and receive wireless signals to communicate with wireless
local area networks (WLANs).

(2)

WWAN antennas (2)*

Send and receive wireless signals to communicate with wireless
wide area networks (WWANs).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Wireless antennas (select models only)
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Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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●

Product name (1). This is the product name affixed to the front of the computer.

●

Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

●

Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

●

Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.

●

Model description (5). This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

Chapter 3 Illustrated parts catalog

Computer major components

Computer major components
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Item

Description

Spare part number

(1)

Display assembly (includes 2 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and
cables (select models only))

(2)

Keyboard
Keyboard without pointing stick (2 button TouchPad)
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For use in Belgium

639477-A41

For use in Brazil

639477-201

For use in Bulgaria

639477-261

For use in the Czech Republic and Slovakia

639477-A81

For use in Denmark

639477-081

For use in France

639477-051

For use in French Canada

639477-121

For use in Germany

639477-041

For use in Greece

639477-DJ1

For use in Hungary

639477-211

For use in Iceland

639477-DD1

For use in Israel

639477-BB1

For use in Italy

639477-061

For use in Japan

639477-291

For use in Latin America

639477-161

For use in the Netherlands

639477-B31

For use in Norway

639477-091

For use in Portugal

639477-131

For use in Russia

639477-251

For use in Saudi Arabia

639477-171

For use in Slovenia

639477-BA1

For use in South Korea

639477-AD1

For use in Spain

639477-071

For use in Sweden

639477-B71

For use in Switzerland

639477-BG1

For use in Taiwan

639477-AB1

For use in Thailand

639477-281

For use in Turkey

639477-141

For use in the United Kingdom

639477-031

For use in the United States

639477-001
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Item

Description

Spare part number

Keyboard with pointing stick (includes pointing stick and pointing stick cable)

(3)

For use in Belgium

639478-A41

For use in Brazil

639478-201

For use in Bulgaria

639478-261

For use in the Czech Republic and Slovakia

639478-A81

For use in Denmark

639478-081

For use in France

639478-051

For use in French Canada

639478-121

For use in Germany

639478-041

For use in Greece

639478-DJ1

For use in Hungary

639478-211

For use in Iceland

639478-DD1

For use in Israel

639478-BB1

For use in Italy

639478-061

For use in Japan

639478-291

For use in Latin America

639478-161

For use in the Netherlands

639478-B31

For use in Norway

639478-091

For use in Portugal

639478-131

For use in Russia

639478-251

For use in Saudi Arabia

639478-171

For use in Slovenia

639478-BA1

For use in South Korea

639478-AD1

For use in Spain

639478-071

For use in Sweden

639478-B71

For use in Switzerland

639478-BG1

For use in Taiwan

639478-AB1

For use in Thailand

639478-281

For use in Turkey

639478-141

For use in the United Kingdom

639478-031

For use in the United States

639478-001

Top cover (includes TouchPad button and bracket)
Top cover includes fingerprint reader and TouchPad (2 button)

639485-001

Top cover includes TouchPad (2 button)

639486–001

Computer major components
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Item

(4)

Description

Spare part number

Top cover includes fingerprint reader and TouchPad (4 button)

641736–001

Top cover includes TouchPad (4 button)

641737–001

Processor
Intel Core i7 processor, Dual Core
2nd Generation Intel Core i7-2620M, 2.70GHz (Turbo up to 3.40GHz) 4MB L3 Cache, 4
threads

631252-001

Intel Core i5 processors, Dual Core
2nd Generation Intel Core i5-2540M, 2.60-GHz (Turbo up to 3.30) processor 3-MB L3
cache, 4 threads

631255-001

2nd Generation Intel Core i5-2520M, 2.50-GHz (Turbo up to 3.20) processor 3-MB L3
cache, 4 threads

631253-001

2nd Generation Intel Core i5-2410M, 2.30-GHz (Turbo up to 2.90) processor 3-MB L3
cache, 4 threads

638039-001

Intel Core i3 processors, Dual Core
Intel Core i3-2330M, 2.20-GHz processor 3-MB L3 cache, 4 threads

653339-001

Intel Core i3-2310M, 2.10-GHz processor 3-MB L3 cache, 4 threads

638037-001

Intel Celeron processor

(5)

Celeron B810, 1.60GHz, 2MB L3 Cache, 2 threads

646760-001

Heat sink (includes replacement thermal material)

639475-001 or

NOTE:

661525-001

If 639475-001 is not available, use 661525-001.

(6)

Fan

639474-001

(7)

Modem module

628824-001

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 639473-001. See
Cable Kit on page 30 for more Cable Kit spare part number information.
(8)

WLAN module
Intel Wi-Fi Link 6205, 802.11a/b/g/n for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda,
Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile,
the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory
Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico,
Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines,
Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal,
Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United
Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands,
Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe
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631954-001

Item

Description

Spare part number

Intel Wi-Fi Link 1000, 802.11b/g/n for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda,
Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile,
the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory
Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico,
Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines,
Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal,
Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United
Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands,
Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe

572520-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda,
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago,
the U.S. Virgin Islands, and the United States

582564-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros,
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, GuineaBissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

582564-002

Broadcom 4313 BGN 802.11b/g/n WLAN module for use in Antigua and Barbuda,
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago,
the U.S. Virgin Islands, and the United States

593836-001

Computer major components
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Item

Description

Spare part number

Broadcom 4313 BGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros,
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, GuineaBissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

593836-002

(9)

Wireless/web/mute function board (includes cable)

639480-001

(10)

RTC battery

651038-001

(11)

Power button board (includes cable)

639481-001

(12)

System board (includes replacement thermal material)

(13)

System board (HM65 includes WWAN and RTC battery) for use in all countries and
regions except for Russia and China

641733-001

System board (HM65 includes WWAN and RTC battery) for use in Russia and China

650161-001

System board (HM65 includes RTC battery) for use in all countries and regions except for
Russia and China

643216–001

System board (HM65 includes RTC battery) for use in Russia and China

650163-001

System board (QM67 includes RTC battery) for use in all countries and regions except for
Russia and China

641734–001

System board (QM67 includes RTC battery) for use in Russia and China

650162-001

Optical drive (includes bracket, bezel, and screws)
DVD±RW SuperMulti DL LightScribe Drive

647673-001

DVD-ROM Drive

647672-001

Blu-ray ROM DVD±RW SuperMulti DL LightScribe Drive

647674-001

(14)

Speaker assembly

639484-001

(15)

Battery
9-cell Li-ion battery
100-Wh battery
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631243-001

Item

Description

Spare part number

73-Wh battery

634089-001

6-cell Li-ion battery
62-Wh battery

628668-001

55-Wh HP Long Life battery

628670-001

55-Wh battery

628666-001

3-cell Li-ion battery
31-Wh battery

628664-001

(16)

Base enclosure (includes rubber feet)

639468-001

(17)

Bottom cover

646077-001

(18)

Hard drive (includes hard drive bracket and screws)

(19)

(20)

750-GB, 7200-rpm

633252-001

500-GB, 7200-rpm

634926-001

320-GB, 7200-rpm

641672-001

320-GB, 7200-rpm, Self-Encrypting Drive (SED)

626978-001

250-GB, 7200-rpm

635225-001

160-GB solid-state drive

649657-001

128-GB solid-state drive

649658-001

Memory modules (PC3-10600, 1333-MHz, DDR3)
8-GB

634091-001

4-GB

621569-001

2-GB

621565-001

Bluetooth module (does not include Bluetooth module cable)

537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 639473-001.
See Cable Kit on page 30 for more Cable Kit spare part number information.
WWAN modules (not illustrated)
HP F5521 Broadband

632155-001

HP un2430 EV-DO/HSPA Mobile Broadband Module

634400-001

Fingerprint reader board (not illustrated; includes fingerprint reader board cable)

651913-001

Cable Kit (not illustrated; see Cable Kit on page 30 for more Cable Kit spare part number
information)

639473-001

Computer major components

27

Display components

Item

Description

(1)

Display bezel
For use with computer models with a webcam

639469-001

For use with computer models without a webcam

639470-001

(2)

Webcam module

641735-001

(3)

Display hinges (Hinge kit includes left and right hinges, brackets, and covers)

639476-001

(4)

Display cable kit includes LCD cable, LCD cable (system board to color mapping
board), LCD cable (color mapping board to panel)

(5)
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Spare part number

For use with computer models with a webcam

639471-001

For use with computer models without a webcam

639472-001

Display enclosure (LCD back cover assembly)

639467-001
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Item

Description

Spare part number

Display panel (not illustrated)

647671-001

Display Panel Support Kit (not illustrated), includes:

657833-001

●

WLAN antennas

●

WWAN antennas

●

Camera cable

●

Display panel rear cover

Plastics Kit

Item

Description

Spare part number

Plastics Kit:

639482-001

(1)

Base enclosure

(2)

Bottom cover
ExpressCard slot protective insert (not illustrated)
LCD hinge covers (left and right; not illustrated)

Plastics Kit
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Cable Kit

Item

30

Description

Spare part number

Cable Kit:

639473-001

(1)

RJ-11 connector cable

(2)

Bluetooth module cable

(3)

TouchPad cable

(4)

Power connector cable

(5)

ExpressCard cable
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Hinge Kit

Item

Description

Spare part number

Hinge Kit:

639476-001

(1)

Left hinge assembly

(2)

Right hinge assembly
LCD hinge covers (left and right; not illustrated)

Hinge Kit
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Mass storage devices

Item

Description

(1)

Optical drive

(2)

32

Spare part number

DVD±RW SuperMulti DL LightScribe Drive

647673-001

Blu-ray ROM DVD±RW SuperMulti DL LightScribe Drive

647674-001

DVD-ROM Drive

647672-001

Hard drive (includes bracket and screws)
750-GB, 7200-rpm

633252-001

500-GB, 7200-rpm

634926-001

320-GB, 7200-rpm

641672-001

320-GB, 7200-rpm, Self-Encrypting Drive (SED)

626978-001

250-GB, 7200-rpm

635225-001

256-GB solid-state drive (SSD)

649658-001

160-GB solid-state drive (SSD)

649657-001
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Miscellaneous parts
Description

Spare part number

AC adapter
65-W AC adapter

609939-001

90-W AC adapter

609940-001

90-W AC adapter for use in India

609947-001

65-W AC adapter for use in India

609948-001

Power cords:
For use in Argentina

490371-D01

For use in Australia

490371-011

For use in Brazil

490371-202

For use in Denmark

490371-081

For use in Europe, the Middle East, and Africa

490371-021

For use in India

490371-D01

For use in Israel

490371-BB1

For use in Italy

490371-061

For use in Japan

490371-291

For use in the People's Republic of China

490371-AA1

For use in South Africa

490371-AR1

For use in South Korea

490371-AD1

For use in Switzerland

490371-111

Power cord for use in Taiwan

490371-AB1

Power cord for use in Thailand

490371-201

For use in the United Kingdom

490371-031

For use in the United States

490371-001

Rubber Kit (includes rubber feet and rubber screw covers)

639483-001

Miscellaneous parts

33

Description

Spare part number

Screw Kit

647676-001

●

Phillips PM2.0×5.0 captive screw

●

Black Phillips PM2.5×12.0 captive screw

●

Silver Phillips PM2.5×12.0 captive screw

●

Phillips PM2.0×7.0 captive screw

●

Phillips PM2.0×4.0 screw

●

Phillips PM3.0×3.0 screw

●

Phillips PM2.5×5.0 screw

●

Phillips PM2.5×3.0 screw

●

Phillips PM2.0×3.0 screw

●

Black Phillips PM2.5×6.0 screw

●

Black Phillips PM2.0×5.0 screw

●

Torx T8M2.5×7.0 screw

●

Torx T8M2.5×8.0 screw

●

Torx T8M2.0×8.0 screw

●

Torx T8M2.5×6.0 screw

Cases
HP Basic Carrying Case

455084-001

Professional slim case, top load

592923-001

Essential Nylon Case

612757-001

HP Docking Station

581597-001

Upgrade bay insert

666230-001

Combination lock

591699-001

Mice
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Optical, USB

390632-001

Travel, USB

434594-001
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Sequential part number listing
Spare part
number

Description

390632-001

Mouse, optical, USB

434594-001

Mouse, travel, USB

455084-001

HP Basic Carrying Case

490371-001

Power cord for use in North America

490371-011

Power cord for use in Australia

490371-021

Power cord for use in Europe, the Middle East, and Africa

490371-031

Power cord for use in the United Kingdom

490371-061

Power cord for use in Italy

490371-081

Power cord for use in Denmark

490371-111

Power cord for use in Switzerland

490371-201

Power cord for use in Thailand

490371-202

Power cord for use in Brazil

490371-291

Power cord for use in Japan

490371-AA1

Power cord for use in the People's Republic of China

490371-AB1

Power cord for use in Taiwan

490371-AD1

Power cord for use in South Korea

490371-AR1

Power cord for use in South Africa

490371-BB1

Power cord for use in Israel

490371-D01

Power cord for use in Argentina

490371-D61

Power cord for use in India

537921-001

Bluetooth module

572520-001

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia and
Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, the People's Republic of China,
Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic, Ecuador, Egypt, El
Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe,
Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy,
Ivory Coast, Jamaica, Japan, Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan, Latvia, Lebanon,
Martinique, US Virgin Islands, Puerto Rico, Nether Antilles, Liechtenstein, Lithuania, Luxembourg, Malawi,
Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Netherlands, New Zealand,
Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines, Poland, Portugal,
Qatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, Spain,
Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the United
Arab Emirates, the United Kingdom, the United States, Uruguay, Venezuela, Vietnam, Yemen, Zambia, and
Zimbabwe

581597-001

HP Docking Station

582564-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the
United States

Sequential part number listing

35

36

Spare part
number

Description

582564-002

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

591699-001

Combination lock

592923-001

Professional slim case, top load

593836-001

Broadcom 4313 BGN 802.11b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the
United States

593836-002

Broadcom 4313 BGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

609939-001

65-W AC adapter

609940-001

90-W AC adapter

609947-001

90-W AC adapter for use in India

609948-001

65-W AC adapter for use in India

612757-001

Essential Nylon Case
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Spare part
number

Description

621565-001

2-GB memory module (PC3-10600, 1333-MHz, DDR3)

621569-001

4-GB memory module (PC3-10600, 1333-MHz, DDR3)

626978-001

320-GB, 7200-rpm, Self-Encrypting Drive (SED)

628664-001

3-cell, 31-Wh Li-ion battery

628666-001

6-cell, 55-Wh Li-ion battery

628668-001

6-cell, 62-Wh Li-ion battery

628670-001

6-cell, 55-Wh HP Long Life Li-ion battery

628824-001

Modem module for use in all countries and regions
NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 639473-001. See Cable Kit on page 30 for more Cable
Kit spare part number information.

631243-001

9-cell, 100-Wh Li-ion battery

631252-001

2nd Generation Intel Core i7-2620M, 2.70GHz (Turbo up to 3.40GHz) 4MB L3 Cache, 4 threads

631253-001

2nd Generation Intel Core i5-2520M, 2.50-GHz (Turbo up to 3.20) processor 3-MB L3 cache, 4 threads

631255-001

2nd Generation Intel Core i5-2540M, 2.60-GHz (Turbo up to 3.30) processor 3-MB L3 cache, 4 threads

631954-001

Intel Wi-Fi Link 6205, 802.11a/b/g/n WLAN module for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia and
Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, the People's Republic of China,
Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic, Ecuador, Egypt, El
Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe,
Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy,
Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro,
Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan,
Panama, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi
Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United Arab Emirates,
the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela, Vietnam, Yemen,
Zambia, and Zimbabwe

632155-001

HP F5521 Broadband Module (WWAN)

633252-001

750-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

634089-001

9-cell, 73-Wh Li-ion battery

634091-001

8-GB memory module (PC3-10600, 1333-MHz, DDR3)

634400-001

HP un2430 EV-DO/HSPA Mobile Broadband Module

634926-001

500-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

635225-001

250-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

638037-001

Intel Core i3-2310M, 2.10-GHz processor 3-MB L3 cache, 4 threads

638039-001

2nd Generation Intel Core i5-2410M, 2.30-GHz (Turbo up to 2.90) processor 3-MB L3 cache, 4 threads

639467-001

Display enclosure (LCD back cover assembly)

639468-001

Base enclosure

Sequential part number listing
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Spare part
number

Description

639469-001

Display bezel for use with computer models with a webcam

639470-001

Display bezel for use with computer models without a webcam

639471-001

Display cable kit, includes LCD cable, LCD cable (system board to color mapping board), LCD cable (color
mapping board to panel). For use with computer models with a webcam.

639472-001

Display cable kit, includes LCD cable, LCD cable (system board to color mapping board), LCD cable (color
mapping board to panel). For use with computer models without a webcam.

639473-001

Cable Kit (see Cable Kit on page 30 for more Cable Kit spare part information)

639474-001

Fan

639475-001

Heat sink (does not include fan)
NOTE:
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If 639475-001 is not available, use 661525-001.

639476-001

Display hinge kit (includes left and right hinges, brackets, and covers)

639477-001

Keyboard without pointing stick for use in the United States

639477-121

Keyboard without pointing stick for use in French Canada

639477-201

Keyboard without pointing stick for use in Brazil

639477-161

Keyboard without pointing stick for use in Latin America

639477-BA1

Keyboard without pointing stick for use in Slovenia

639477-171

Keyboard without pointing stick for use in Saudi Arabia

639477-A41

Keyboard without pointing stick for use in Belgium

639477-261

Keyboard without pointing stick for use in Bulgaria

639477-A81

Keyboard without pointing stick for use in the Czech Republic and Slovakia

639477-081

Keyboard without pointing stick for use in Denmark

639477-B31

Keyboard without pointing stick for use in the Netherlands and Europe

639477-051

Keyboard without pointing stick for use in France

639477-041

Keyboard without pointing stick for use in Germany

639477-DJ1

Keyboard without pointing stick for use in Greece

639477-DD1

Keyboard without pointing stick for use in Iceland

639477-211

Keyboard without pointing stick for use in Hungary

639477-BB1

Keyboard without pointing stick for use in Israel

639477-061

Keyboard without pointing stick for use in Italy

639477-091

Keyboard without pointing stick for use in Norway

639477-131

Keyboard without pointing stick for use in Portugal

639477-251

Keyboard without pointing stick for use in Russia

639477-071

Keyboard without pointing stick for use in Spain

639477-B71

Keyboard without pointing stick for use in Sweden
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Spare part
number

Description

639477-BG1

Keyboard without pointing stick for use in Switzerland

639477-141

Keyboard without pointing stick for use in Turkey

639477-031

Keyboard without pointing stick for use in the United Kingdom

639477-291

Keyboard without pointing stick for use in Japan

639477-AD1

Keyboard without pointing stick for use in South Korea

639477-AB1

Keyboard without pointing stick for use in Taiwan

639477-281

Keyboard without pointing stick for use in Thailand

639478-001

Keyboard with pointing stick for use in the United States (includes keyboard and pointing stick cables)

639478-121

Keyboard with pointing stick for use in French Canada (includes keyboard and pointing stick cables)

639478-201

Keyboard with pointing stick for use in Brazil (includes keyboard and pointing stick cables)

639478-161

Keyboard with pointing stick for use in Latin America (includes keyboard and pointing stick cables)

639478-BA1

Keyboard with pointing stick for use in Slovenia (includes keyboard and pointing stick cables)

639478-171

Keyboard with pointing stick for use in Saudi Arabia (includes keyboard and pointing stick cables)

639478-A41

Keyboard with pointing stick for use in Belgium (includes keyboard and pointing stick cables)

639478-261

Keyboard with pointing stick for use in Bulgaria (includes keyboard and pointing stick cables)

639478-A81

Keyboard with pointing stick for use in the Czech Republic and Slovakia (includes keyboard and pointing
stick cables)

639478-081

Keyboard with pointing stick for use in Denmark (includes keyboard and pointing stick cables)

639478-B31

Keyboard with pointing stick for use in the Netherlands and Europe (includes keyboard and pointing stick
cables)

639478-051

Keyboard with pointing stick for use in France (includes keyboard and pointing stick cables)

639478-041

Keyboard with pointing stick for use in Germany (includes keyboard and pointing stick cables)

639478-DJ1

Keyboard with pointing stick for use in Greece (includes keyboard and pointing stick cables)

639478-DD1

Keyboard with pointing stick for use in Iceland (includes keyboard and pointing stick cables)

639478-211

Keyboard with pointing stick for use in Hungary (includes keyboard and pointing stick cables)

639478-BB1

Keyboard with pointing stick for use in Israel (includes keyboard and pointing stick cables)

639478-061

Keyboard with pointing stick for use in Italy (includes keyboard and pointing stick cables)

639478-091

Keyboard with pointing stick for use in Norway (includes keyboard and pointing stick cables)

639478-131

Keyboard with pointing stick for use in Portugal (includes keyboard and pointing stick cables)

639478-251

Keyboard with pointing stick for use in Russia (includes keyboard and pointing stick cables)

639478-071

Keyboard with pointing stick for use in Spain (includes keyboard and pointing stick cables)

639478-B71

Keyboard with pointing stick for use in Sweden (includes keyboard and pointing stick cables)

639478-BG1

Keyboard with pointing stick for use in Switzerland (includes keyboard and pointing stick cables)

639478-141

Keyboard with pointing stick for use in Turkey (includes keyboard and pointing stick cables)

Sequential part number listing
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Spare part
number

Description

639478-031

Keyboard with pointing stick for use in the United Kingdom (includes keyboard and pointing stick cables)

639478-291

Keyboard with pointing stick for use in Japan (includes keyboard and pointing stick cables)

639478-AD1

Keyboard with pointing stick for use in South Korea (includes keyboard and pointing stick cables)

639478-AB1

Keyboard with pointing stick for use in Taiwan (includes keyboard and pointing stick cables)

639478-281

Keyboard with pointing stick for use in Thailand (includes keyboard and pointing stick cables)

639479-001

ExpressCard assembly

639480-001

Wireless/web/mute function board (includes cable)

639481-001

Power button board

639482-001

Plastics Kit (see Plastics Kit on page 29 for more Plastics Kit spare part information)

639483-001

Rubber Kit (includes rubber feet and rubber screw covers)

639484-001

Speaker assembly

639485-001

Top cover (includes finger print reader, Touchpad (2 button) and bracket))

639486-001

Top cover (includes Touchpad (2 button) and bracket))

641672-001

320-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

641733-001

System board (HM65 includes WWAN and RTC battery) for use in all countries and regions except for
Russia and China

641734-001

System board (QM67 includes RTC battery) for use in all countries and regions except for Russia and
China

641735-001

Webcam module

641736-001

Top cover (includes finger print reader, Touchpad (4 button) and bracket))

641737-001

Top cover (includes Touchpad (4 button) and bracket))

643216-001

System board (HM65 includes RTC battery) for use in all countries and regions except for Russia and
China

646760-001

Intel Celeron B810, 1.60GHz, 2MB L3 Cache, 2 threads

647671-001

Display panel

647672-001

DVD-ROM drive

647673-001

DVD±RW SuperMulti DL LightScribe Drive

647674-001

Blu-ray ROM DVD±RW SuperMulti DL LightScribe Drive

647675-001

Microphone board (includes microphone, and microphone mylar)

647676-001

Screw Kit

649657-001

160-GB solid-state drive (SSD) (includes hard drive bracket and screws)

649658-001

128-GB solid-state drive (SSD) (includes hard drive bracket and screws)

650161-001

System board (HM65 includes WWAN and RTC battery) for use in Russia and China

650162-001

System board (QM67 includes RTC battery) for use in Russia and China

650163-001

System board (HM65 includes RTC battery) for use in Russia and China
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Spare part
number

Description

651038-001

RTC battery

651649-001

HDD Hardware Kit

651656-001

Smart Card reader

651913-001

Fingerprint reader board (includes fingerprint reader board cable)

653339-001

Intel Core i3-2330M, 2.20-GHz processor 3-MB L3 cache, 4 threads

657833-001

Display Panel Support Kit

661525-001

Heat sink

666230-001

Upgrade bay insert

Sequential part number listing
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Removal and replacement procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Phillips P0 and P1 screwdrivers

●

Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing an optical drive, be sure that the disc is not in the drive and be sure that the optical
drive tray is closed.
Handle drives on surfaces covered with at least 2.5 cm (one inch) of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive or an optical drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Preliminary replacement requirements
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, and then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event
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10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Preliminary replacement requirements
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 95 screws and screw locks, in 15 different sizes, that must be removed,
replaced, or loosened when servicing the computer. Make special note of each screw and screw lock
size and location during removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

●

Product name (1). This is the product name affixed to the front of the computer.

●

Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

●

Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

●

Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.

●

Model description (5). This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

Component replacement procedures
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 639483-001. There are 5 rubber feet that attach to the base enclosure/bottom cover in
the locations illustrated below.
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Battery
Description

Spare part number

9-cell, 100-Wh Li-ion battery

631243-001

9-cell, 73-Wh Li-ion battery

634089-001

6-cell, 62-Wh Li-ion battery

628668–001

6-cell, 55-Wh Li-ion battery

628666-001

6-cell, 55-Wh HP Long Life Li-ion battery

628670-001

3-cell, 31-Wh Li-ion battery

628664-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the battery:
1.

Turn the computer upside-down on a flat surface, with the battery bay toward you.

2.

Slide the battery release latch (1) to release the battery.

3.

Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.

Component replacement procedures
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SIM
NOTE:

This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.
Before removing the SIM, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

Remove the SIM:
1.

Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2.

Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Bottom cover
NOTE:

The optional screw is located on the inside of the bottom cover.

Description

Spare part number

Bottom cover

646077-001

Before removing the bottom cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

Remove the bottom cover:
1.

Turn the computer upside-down on a flat surface, with the battery bay toward you.

2.

Slide the bottom cover release latch (1) to the left, remove the screw (if the optional screw is
being used) (2).

3.

Slide the release latch again (3) to release the bottom cover.

4.

Slide the bottom cover towards the front of the computer (4) and lift (5) to remove the cover.

Component replacement procedures
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.
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Description

Spare part number

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda,
Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium,
Bermuda, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands,
Chile, the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan,
Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique, US Virgin Islands,
Puerto Rico, Nether Antilles, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta,
Mauritius, Mexico, Monaco, Montenegro, Morocco, the Netherlands, New Zealand, Nicaragua,
Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines, Poland, Portugal, Qatar,
Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa,
Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago,
Turkey, the United Arab Emirates, the United Kingdom, the United States, Uruguay, Venezuela,
Vietnam, Yemen, Zambia, and Zimbabwe

572520-001

Intel Wi-Fi Link 6205, 802.11a/b/g/n WLAN module for use in Andorra, Antigua and Barbuda,
Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium,
Bermuda, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands,
Chile, the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan,
Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, the
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan,
Panama, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San
Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain,
Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia,
Turkey, the United Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S.
Virgin Islands, Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe

631954-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

582564-001
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Description

Spare part number

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

582564-002

Broadcom 4313 BGN 802.11b/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

593836-001

Broadcom 4313 BGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

593836-002

Before removing the WLAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the bottom cover (see Bottom cover on page 51).

Remove the WLAN module:
1.

Turn the computer upside-down, with the front toward you.

2.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The WLAN antenna cable (“Black” tag labelled (1)) is connected to the WLAN module
“Main” terminal. The WLAN antenna cable (“White” tag labelled (2)) is connected to the WLAN
module “Aux” terminal.

3.

Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

4.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.
NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.
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Reverse this procedure to install the WLAN module.
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Optical drive
NOTE:

All optical drive spare part kits include an optical drive bezel.

Description

Spare part number

DVD±RW SuperMulti DL LightScribe Drive

647673-001

Blu-ray ROM DVD±RW SuperMulti DL LightScribe Drive

647674-001

DVD-ROM Drive

647672-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the bottom cover (see Bottom cover on page 51).

Remove the optical drive:
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1.

Position the computer upside-down with the right side toward you.

2.

Remove the Phillips PM2.5×12.0 captive screw (1) that secures the optical drive to the
computer.

3.

Push the optical drive tab (2) to release the optical drive from the computer.
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4.

Remove the optical drive (3) from the computer.

5.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.

6.

Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7.

Remove the optical drive bracket (2).

Reverse this procedure to install an optical drive.
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Upgrade bay
Description

Spare part number

320-GB, 7200-rpm, Self-Encrypting Drive (SED)

626978-001

Upgrade bay insert

666230-001

Before removing a drive from the upgrade bay, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the bottom cover (see Bottom cover on page 51).

Remove the drive from the upgrade bay:
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1.

Position the computer upside-down, with the front toward you.

2.

Remove the four Phillips PM2.0×4.0 screws that secure the hard drive assembly into the
upgrade bay.

3.

Remove the Phillips PM2.5×12.0 captive screw (1) that secures the optical drive to the
computer.

4.

Push the optical drive tab (2) to release the drive from the computer.
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5.

Remove the optical drive (3) from the computer.

6.

Remove the assembly from the base enclosure.

Reverse this procedure to install the hard drive into the upgrade bay.
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Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket and screws.
Description

Spare part number

750-GB, 7200-rpm hard drive

633252-001

500-GB, 7200-rpm hard drive

634926-001

320-GB, 7200-rpm hard drive

641672-001

250-GB, 7200-rpm hard drive

635225-001

160-GB solid-state drive (SSD)

649657-001

128-GB solid-state drive (SSD)

649658-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the bottom cover (see Bottom cover on page 51).

Remove the hard drive:
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1.

Position the computer upside-down, with the battery bay toward you.

2.

Loosen the three Phillips PM2.5×12.0 captive screws (1) that secures the hard drive to the
computer.

3.

Grasp the Mylar tab (2) on the hard drive and slide the hard drive to the left to disconnect it from
the system board.
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4.

Use the plastic tab to lift the connector side of the hard drive up at an angle (3) and remove the
drive (4) from the hard drive bay.

5.

If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0×5.0 hard drive
bracket screws (1) from each side of the hard drive.

6.

Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 639473-001. See Cable Kit
on page 30 for more Cable Kit spare part number information.
Description

Spare part number

Bluetooth module

537921-001

Before removing the Bluetooth module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the bottom cover (see Bottom cover on page 51).

Remove the Bluetooth module:
1.

Position the computer upside-down, with the front toward you.

2.

Remove the Bluetooth module by lifting it straight up and out of the compartment (1) as far as
the cable allows.

3.

Disconnect the Bluetooth module cable (2) from the Bluetooth module.

Reverse this procedure to install the Bluetooth module.

62

Chapter 4 Removal and replacement procedures

Expansion memory modules
NOTE: There are two memory slots. Expansion memory is installed in a compartment containing a
single slot (slot 2) on the bottom of the computer and the primary memory is installed in a
compartment containing a single slot (slot 1) under the keyboard.
Slot 2 cannot be populated if slot 1 is not populated.
Description

Spare part number

2-GB (PC3-10600, 1333-MHz, DDR3)

621565-001

4-GB (PC3-10600, 1333-MHz, DDR3)

621569-001

8-GB (PC3-10600, 1333-MHz, DDR3)

634091-001

Update BIOS before adding memory modules
Before adding new memory, make sure you update the computer to the latest BIOS.
CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.
To update BIOS:
1.

Navigate to www.hp.com.

2.

Click Support & Drivers > click Drivers & Software.

3.

In the Enter a product name/number box, type the computer model information, and then click
Search.

4.

Click the link for the computer model.

5.

Select the operating system, and then click Next.

6.

Under Step 2: Select a Download, click the BIOS link.

7.

Click the link for the most recent BIOS.

8.

Click the Download button, and then follow the on-screen instructions.

Before removing the memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the bottom cover (see Bottom cover on page 51).
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Remove the expansion memory module:
1.

Position the computer upside-down, with the front toward you.

2.

Spread the retaining tabs (1) on each side of the expansion memory module slot to release the
memory module. (The edge of the module opposite the slot rises away from the computer.)

3.

Remove the expansion memory module (2) by pulling the module away from the slot at an
angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install an expansion memory module.

64

Chapter 4 Removal and replacement procedures

Keyboard
For use in:

Spare part number

For use in:

Spare part number

Keyboards with pointing stick (includes pointing stick cable):
Belgium

639478-A41

Latin America

639478-161

Brazil

639478-201

The Netherlands and Europe

639478-B31

Bulgaria

639478-261

Norway

639478-091

Czech Republic and Slovakia

639478-A81

Portugal

639478-131

Denmark

639478-081

Russia

639478-251

France

639478-051

Saudi Arabia

639478-171

French Canada

639478-121

Slovenia

639478-BA1

Germany

639478-041

Spain

639478-071

Greece

639478-DJ1

Sweden and Finland

639478-B71

Hungary

639478-211

Switzerland

639478-BG1

Iceland

639478-DD1

Taiwan

639478-AB1

Israel

639478-BB1

Thailand

639478-281

Italy

639478-061

Turkey

639478-141

Japan

639478-291

The United Kingdom

639478-031

South Korea

639478-AD1

The United States

639478-001

Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

Remove the keyboard:
1.

Turn the computer upside-down, with the rear toward you.

2.

Loosen the three Phillips PM2.5×12.0 captive screws (1) that secure the keyboard to the
computer.
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3.

Release the keyboard by pressing down on the keyboard release cut-out (2).

4.

Turn the computer right-side up, with the front toward you.

5.

Open the computer as far as possible.

6.

Lift the top edge of the keyboard, and then rotate the keyboard forward until it rests upside-down
on top of the TouchPad.

7.

Release the zero insertion force (ZIF) connector to which the keyboard cable (1) is attached, and
then disconnect the keyboard cable from the system board.
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8.

Release the ZIF connector to which the pointing stick cable (2) is attached, and then disconnect
the pointing stick cable from the system board.

9.

Remove the keyboard.

Reverse this procedure to install the keyboard.
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WWAN module
CAUTION: The WWAN module and the WLAN module are not interchangeable.
NOTE:

Ericsson modules are only available in EMEA on certain computers.

Description

Spare part number

HP F5521 Broadband Module (WWAN)

632155-001

HP un2430 EV-DO/HSPA Mobile Broadband Module

634400-001

Before removing the WWAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the SIM (see SIM on page 50).

6.

Remove the keyboard (see Keyboard on page 65).

Remove the WWAN module:
1.

Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.
NOTE: The WWAN antenna cable (“Red” tag labelled (5)) is connected to the WWAN module
“Main” terminal. The WWAN antenna cable (“Blue” tag labelled (6)) is connected to the WWAN
module “Aux” terminal.
There are two different WWAN modules available, and each module has the antenna connectors
reversed.

2.
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Remove the two Phillips PM2.5×3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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3.

Remove the WWAN module (3) by pulling the module away from the slot at an angle.
NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.
Figure 4-1 Ericsson module antenna locations

Figure 4-2 Qualcomm module antenna locations

NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.
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Reverse this procedure to install the WWAN module.

Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 639473-001. See Cable Kit on page 30
for more Cable Kit spare part number information.
Description

Spare part number

Modem module for use in all countries and regions

628824-001

Before removing the modem module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the bottom cover (see Bottom cover on page 51).

Remove the modem module:
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1.

Position the computer upside-down, with the front toward you.

2.

Remove the Phillips PM2.0×3.0 screws (1) that secure the modem module to the system board.

3.

Disconnect the modem module (2) from the system board by lifting it straight up.
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4.

Disconnect the modem module cable (3) from the modem module.

Reverse this procedure to install the modem module.
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Primary memory module
NOTE: There are two memory slots. Expansion memory is installed in a compartment containing a
single slot (slot 2) on the bottom of the computer and the primary memory is installed in a
compartment containing a single slot (slot 1) under the keyboard.
Slot 2 cannot be populated if slot 1 is not populated.
Description

Spare part number

2-GB (PC3-10600, 1333-MHz, DDR3)

621565-001

4-GB (PC3-10600, 1333-MHz, DDR3)

621569-001

8-GB (PC3-10600, 1333-MHz, DDR3)

634091-001

Update BIOS before adding memory modules
Before adding new memory, make sure you update the computer to the latest BIOS.
CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.
To update BIOS:
1.

Navigate to www.hp.com.

2.

Click Support & Drivers > click Drivers & Software.

3.

In the Enter a product name/number box, type the computer model information, and then click
Search.

4.

Click the link for the computer model.

5.

Select the operating system, and then click Next.

6.

Under Step 2: Select a Download, click the BIOS link.

7.

Click the link for the most recent BIOS.

8.

Click the Download button, and then follow the on-screen instructions.

Before removing the primary memory module, follow these steps:

72

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the keyboard (see Keyboard on page 65).
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Remove the primary memory module:
1.

Spread the retaining tabs (1) on each side of the primary memory module slot to release the
memory module. (The edge of the module opposite the slot rises away from the computer.)

2.

Remove the primary memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a primary memory module.
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Fan
Description

Spare part number

Fan

639474-001

Before removing the fan, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the bottom cover (see Bottom cover on page 51).

Remove the fan:
1.

Turn the computer upside-down, with the front toward you.

2.

Disconnect the fan cable (1) from the system board.

3.

Remove the two Phillips PM 2.5x5.0 screws (2) that secure the fan to the base enclosure.

4.

Lift the fan (3) from the base enclosure.

Reverse this procedure to install the fan.
NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-in) clearance on the left side of
the computer.
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The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is
displaced through the ventilation grill located on the left side of the computer.

Heat sink
All heat sink spare part kits include replacement thermal material.
Description

Spare part number

Heat sink (does not include fan)

639475-001 or

NOTE: If 639475-001 is not available, use 661525-001.

661525-001

Before removing the heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Remove the bottom cover (see Bottom cover on page 51).

b.

Fan (see Fan on page 74).

Remove the heat sink:
1.

Turn the computer upside-down, with the front toward you.
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2.

Remove the four Torx T8M2.0x8.0 screws (1) that secure the heat sink to the base enclosure.

3.

Lift the right side of the heat sink (1) to disengage it from the system board.

4.

Rotate and lift the heat sink counter-clockwise (2) to clear the base enclosure, and then remove
it from the computer.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) each
time the heat sink is removed. Thermal material is included with all heat sink and processor spare
part kits.
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Reverse this procedure to install the heat sink.

Processor
NOTE:

All processor spare part kits include replacement thermal material.

Description

Spare part number

Intel Core i7 processor, Dual Core
2nd Generation Intel Core i7-2620M, 2.70GHz (Turbo up to 3.40GHz) 4MB L3 Cache, 4 threads

631252-001

Intel Core i5 processors, Dual Core
2nd Generation Intel Core i5-2540M, 2.60-GHz (Turbo up to 3.30) processor 3-MB L3 cache, 4
threads

631255-001

2nd Generation Intel Core i5-2520M, 2.50-GHz (Turbo up to 3.20) processor 3-MB L3 cache, 4
threads

631253-001

2nd Generation Intel Core i5-2410M, 2.30-GHz (Turbo up to 2.90) processor 3-MB L3 cache, 4
threads

638039-001

Intel Core i3 processors, Dual Core
Intel Core i3-2330M, 2.20-GHz processor 3-MB L3 cache, 4 threads

653339-001

Intel Core i3-2310M, 2.10-GHz processor 3-MB L3 cache, 4 threads

638037-001

Intel Celeron processor
Celeron B810, 1.60GHz, 2MB L3 Cache, 2 threads

646760-001
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Before removing the processor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Keyboard (see Keyboard on page 65)

b.

Remove the bottom cover (see Bottom cover on page 51).

c.

Fan (see Fan on page 74).

d.

Heat sink (see Heat sink on page 75).

Remove the processor:
1.

Turn the computer upside-down, with the front toward you.

2.

Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3.

Lift the processor (2) straight up and remove it.
NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed
on the processor slot when you install the processor.

Reverse this procedure to install the processor.
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Base enclosure
Description

Spare part number

Base enclosure

639468-001

Before removing the base enclosure, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 52) and the WWAN module (see WWAN module on page 68).

6.

Remove the keyboard (see Keyboard on page 65).

7.

Remove the fan (see Fan on page 74).

8.

Remove the heat sink (see Heat sink on page 75).

Remove the base enclosure:
1.

Position the computer right-side up, with the front toward you.

2.

Remove the Two Torx T8M2.5×7.0 screws from under the keyboard.

3.

Position the computer right-side up, with the rear toward you.
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4.

Remove the Four Torx T8M2.5×7.0 screws from the back of the unit that secure the display
assembly to the computer.

5.

Position the computer upside-down, with the front toward you.

6.

Remove the following covers and Torx screws:
(1) Four rubber screw covers
(2) Eight Torx T8M2.5×7.0 screws
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7.

Remove the following Phillips screws:
(1) Three Phillips PM2.0×3.0bh screws in the battery bay
(2) Two Phillips PM2.0×3.0 screws in the ODD drive bay

8.

Lift the base enclosure (1) up and forward.

9.

Disconnect the speaker cable (2).

10. Remove the base enclosure.

CAUTION: When installing the base enclosure, be sure that the wireless antenna cables
routed out of the display assembly are routed and arranged properly.
Failure to follow these routing instructions can result in degradation of the computer's WLAN and
WWAN performance.
Reverse this procedure to reassemble and install the base enclosure.
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Speaker assembly
Description

Spare part number

Speaker assembly (kit)

639484-001

Before removing the speaker assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Fan (see Fan on page 74)

e.

Heat sink (see Heat sink on page 75)

f.

Base enclosure (see Base enclosure on page 79).

Remove the speaker assembly:
1.
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Position the base enclosure upside-down, with the front toward you.
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2.

Remove the Bluetooth cable (1) by unplugging it from the system board (2).

3.

Remove the two Phillips PM2.5×5.0 screws (1) that secure the speaker assembly to the base
enclosure.

4.

Remove the tape (2) from the speaker cable.

5.

Slide the large speaker to the left (3) until the cutout in the speaker lines-up with the metal clip.

6.

Remove the speaker assembly (4) from the base enclosure.

Reverse this procedure to install the speaker assembly.
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Display assembly
All display assemblies include 2 WLAN antenna transceivers and cables, and 2 WWAN antenna
transceivers and cables (select models only).
A Display Panel Support Kit is available using spare part number 657833-001. The kit includes:
●

WLAN antennas

●

WWAN antennas

●

Camera cable

●

Display panel rear cover

Before removing the display assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 52) and the WWAN module (see WWAN module on page 68).

6.

Remove the keyboard (see Keyboard on page 65).

7.

Remove the base enclosure (see Base enclosure on page 79).

Remove the display assembly:
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1.

Position the computer right-side up, with the front toward you.

2.

Disconnect the display panel cable (1) from the system board (2).
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3.

Push the display panel cable through the pass-thru cutout in the base enclosure (3).

4.

Position the computer upside-down, with the front toward you.
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5.

Remove the following:
(1) Display panel cable and tape from top cover
(2) Display panel cable from clips in top cover
(3) Two WLAN cables from routing out of hole in top cover and clips in upper right side of top
cover
(4) Two WLAN cables and tape from top cover
(5) Two WLAN cables from clips in top cover

6.
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Turn the computer right-side up, with the front toward you.
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7.

Pull the display assembly out away from the base enclosure and lift the display assembly (1)
straight up and remove it.

CAUTION: When installing the display assembly, be sure that the wireless antenna cables
routed out of the display right hinge are routed and arranged properly.
Failure to follow these routing instructions can result in degradation of the computer's WLAN and
WWAN performance.
8.

If it is necessary to replace the display bezel or display hinges, remove the following:
(1) Two rubber screw covers on the display bezel bottom edge
(2) Two Phillips PM2.5×5.0 screws on the display bezel bottom edge

9.

Flex the top of the bezel, the inside edges of the left and right sides (1), and then the top and
bottom (2) of the bezel until it disengages from the display enclosure.
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10. Remove the display bezel (3). The display bezel is available using spare part numbers
639469-001 (for use with computer models with a webcam), and 639470-001 (for use with
computer models equipped without a webcam).

11. If it is necessary to replace the webcam module from the display enclosure, disconnect the
webcam cable from the module (1), gently pull the webcam module away from the double-sided
tape on the display enclosure (2), and then remove the webcam (3). The webcam module is
available using spare part number 641735-001.

12. If it is necessary to replace the display panel, remove the six Phillips PM2.5×5.0 screws (1) that
secure the display panel to the display enclosure, four screws on the bottom and two screws on
the top.
13. Remove the display panel (2) from the display panel back cover.
14. Disconnect the webcam/microphone cable (3) from the display assembly.
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15. Remove the display panel (4). The display panel is available using spare part number
647671-001.

16. If it is necessary to remove the display panel cable, remove the tape (1) covering the display
panel cable along with the cable from the back of the display. Disconnect the video board cable
(2). Also, it is necessary to disconnect the webcam/microphone cable and tape that secures this
cable to the display, and then lift the cable and tape away from the display panel (3). The display
panel cable is in the Display Panel Cable Kit, spare part number 639471-001 (with webcam) or
639472–001 (without webcam).

17. If it is necessary to replace the display hinges, remove the six Phillips PM2.5×3.0 screws (1) that
secure each display hinge to the display panel.
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18. If it is necessary to remove the WWAN antenna transceivers (1) and cables, remove them from
the display enclosure back cover by lifting them (2) from the clips in the display enclosure back
cover.

19. If it is necessary to remove the WLAN antenna transceivers (1) and cables, remove them from
the display enclosure back cover by lifting them (2) from the clips in the display enclosure back
cover.

20. If it is necessary to replace the display panel hinges, remove the six Phillips PM2.0×3.0 screws
(1) that secure the display panel hinges to the display panel, three screws on the left and three
screws on the right.
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21. Remove the display hinges (2). The left and right display hinges are available using spare part
number 639476-001.

Reverse this procedure to reassemble and install the display assembly.

System board
NOTE:

All system board spare part kits include replacement thermal material.

Description

Spare part number

System board (HM65 includes WWAN and RTC battery) for use in all countries and regions
except for Russia and China

641733-001

System board (HM65 includes WWAN and RTC battery) for use in Russia and China

650161-001

System board (HM65 includes RTC battery) for use in all countries and regions except for Russia
and China

643216–001

System board (HM65 includes RTC battery) for use in Russia and China

650163-001

System board (QM67 includes RTC battery) for use in all countries and regions except for Russia
and China

641734–001

System board (QM67 includes RTC battery) for use in Russia and China

650162-001

Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.
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4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Modem module (see Modem module on page 70)

e.

Fan (see Fan on page 74)

f.

Heat sink (see Heat sink on page 75)

g.

Base enclosure (see Base enclosure on page 79)

h.

Display assembly (see Display assembly on page 84)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:
●

SIM (see SIM on page 50)

●

Primary memory module (see Primary memory module on page 72

●

Expansion memory module (see Expansion memory modules on page 63)

●

WLAN module (see WLAN module on page 52)

●

WWAN module (see WWAN module on page 68)

●

Processor (see Processor on page 77)

Remove the system board:

92

1.

Position the top cover right-side up, with the front toward you.

2.

Disconnect the power button cable (1) swinging ZIF connector from the system board (2).

3.

Disconnect the TouchPad cable (3) swinging ZIF connector from the system board (4).

4.

Disconnect the wireless/web/mute function board cable (5) swinging ZIF connector from the
system board (6).

5.

Disconnect the fingerprint reader cable (7) swinging ZIF connector from the system board (8).
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6.

Disconnect the power connector cable (9) from the system board (10).

7.

Position the system board upside-down (top cover upside-down)

8.

Remove the two Phillips PM2.5×5.0 screws (1) that secure the system board to the top cover.

9.

Lift up the front edge (2) of the system board.

10. Disconnect the ExpressCard cable (3) swinging ZIF connector from the system board (4).
11. Remove the system board from the chassis (5).
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Reverse the preceding procedure to install the system board.

RTC battery
Description

Spare part number

RTC battery

651038-001

Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Modem module (see Modem module on page 70)

e.

Fan (see Fan on page 74)

f.

Heat sink (see Heat sink on page 75)

g.

Base enclosure (see Base enclosure on page 79)

h.

Display assembly (see Display assembly on page 84)

i.

System board (see System board on page 91)

Remove the RTC battery:
1.
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Position the system board right-side up, with the front toward you.
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2.

Pull the battery out of the socket and remove it from the system board.

Reverse this procedure to install the RTC battery.

Power button board
NOTE:

The power button board assembly spare includes the power button cable.

Description

Spare part number

Power button board assembly

639481-001

Before removing the Power button board assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Modem module (see Modem module on page 70)
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e.

Fan (see Fan on page 74)

f.

Heat sink (see Heat sink on page 75)

g.

Base enclosure (see Base enclosure on page 79)

h.

Display assembly (see Display assembly on page 84)

i.

System board (see System board on page 91)

Remove the Power button board assembly:
1.

Position the top cover upside-down, with the front toward you.

2.

Remove the single Phillips PM2.5×3.0 screw (1) that secures the assembly to the top cover.

3.

Remove the Power button board and cable (2) from the top cover.

Reverse this procedure to install the Power button board assembly.

Wireless/web/mute function board
NOTE:

The Wireless/web/mute function board assembly spare includes the power button cable.

Description

Spare part number

Wireless/web/mute function board assembly

639480-001

Before removing the Wireless/web/mute function board assembly, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.
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4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Modem module (see Modem module on page 70)

e.

Fan (see Fan on page 74)

f.

Heat sink (see Heat sink on page 75)

g.

Base enclosure (see Base enclosure on page 79)

h.

Display assembly (see Display assembly on page 84)

i.

System board (see System board on page 91)

Remove the Wireless/web/mute function board assembly:
1.

Position the top cover upside-down, with the front toward you.

2.

Remove the single Phillips PM2.5×3.0 screw (1) that secures the assembly to the top cover.

3.

Remove the Wireless/web/mute function board and cable (2) from the top cover.

Reverse this procedure to install the Wireless/web/mute function board assembly.
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Fingerprint reader board
NOTE:

The Fingerprint reader board assembly spare includes the fingerprint reader cable.

Description

Spare part number

Fingerprint reader board assembly

651913-001

Before removing the Fingerprint reader board assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49)

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Modem module (see Modem module on page 70)

e.

Fan (see Fan on page 74)

f.

Heat sink (see Heat sink on page 75)

g.

Base enclosure (see Base enclosure on page 79)

h.

Display assembly (see Display assembly on page 84)

i.

System board (see System board on page 91)

Remove the Fingerprint reader board assembly:
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1.

Position the top cover upside-down, with the front toward you.

2.

Remove the single Phillips PM2.5×3.0 screw (1) that secures the assembly to the top cover.

3.

Slide the bracket (2) to remove the clips in top cover and lift off unit.

Chapter 4 Removal and replacement procedures

4.

Remove the Fingerprint reader board and cable (3) from the top cover.

Reverse this procedure to install the Fingerprint reader board assembly.

ExpressCard assembly
Description

Spare part number

ExpressCard assembly

639479-001

Before removing the ExpressCard assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Modem module (see Modem module on page 70)

e.

Fan (see Fan on page 74)
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f.

Heat sink (see Heat sink on page 75)

g.

Base enclosure (see Base enclosure on page 79)

h.

Display assembly (see Display assembly on page 84)

i.

System board (see System board on page 91)

Remove the ExpressCard assembly:
1.

Position the top cover upside-down, with the front toward you.

2.

Remove the three Phillips PM2.5×5.0 screws (1) that secure the assembly to the top cover.

3.

Lift the tab of the assembly (2) until it disengages from the opening in the top cover.

4.

Remove the ExpressCard board and cable (3) from the top cover.

Reverse this procedure to install the ExpressCard assembly.

RJ-11 connector cable
NOTE:

The RJ-11 connector cable is included in the Cable Kit, spare part number 639473-001.

Before removing the RJ-11 connector cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.
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4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Modem module (see Modem module on page 70)

e.

Fan (see Fan on page 74)

f.

Heat sink (see Heat sink on page 75)

g.

Base enclosure (see Base enclosure on page 79)

h.

Display assembly (see Display assembly on page 84)

i.

System board (see System board on page 91)

Remove the RJ-11 connector cable:
1.

Position the top cover upside-down, with the front toward you.

2.

Remove the RJ-11 connector (1) from the clip built into the top cover.

3.

Remove the RJ-11 connector cable from the clips and routing channel (2) built into the top
cover.

4.

Remove the RJ-11 connector cable from the top cover.

Reverse this procedure to install the RJ-11 connector cable.
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Power connector cable
NOTE:

The power connector cable is included in the Cable Kit, spare part number 639473-001.

Before removing the power connector cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 49).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 60)

b.

Optical drive (see Optical drive on page 56)

c.

Keyboard (see Keyboard on page 65)

d.

Modem module (see Modem module on page 70)

e.

Fan (see Fan on page 74)

f.

Heat sink (see Heat sink on page 75)

g.

Base enclosure (see Base enclosure on page 79)

h.

Display assembly (see Display assembly on page 84)

i.

System board (see System board on page 91)

Remove the power connector cable:
1.

Position the top cover upside-down, with the front toward you.

2.

Lift the power connector up from the clips in the rear of the base enclosure.
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3.

Remove the power connector cable from the enclosure.

Reverse this procedure to install the power connector cable.
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5

Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.
NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter BIOS Setup.

Using Computer Setup
Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys, and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.
2.

Press f10 to enter BIOS Setup.

3.

Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.
– or –

●

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter BIOS Setup.

3.

Use a pointing device or the arrow keys to select File > Restore defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Using Computer Setup 105

Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu
Select

To do this

System Information

●

View identification information for the computer and the
batteries in the system.

●

View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time

Set or change the date and time on the computer.

System Diagnostics

Displays the following information:
●

System Information
◦

Identification information for the computer and the
batteries in the system.

◦

Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

●

Start-up Test—Verifies the system components needed
for starting the computer.

●

Run-In Test—Runs a comprehensive check on system
memory.

●

Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

●

Memory Test—Runs a comprehensive test on any
memory installed in the computer.

●

Battery Test—Runs a comprehensive test on any
batteries installed in the computer.

●

Error Log—Displays a log file if any errors have
occurred.

Restore defaults

Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default

Restore the BIOS security settings to the factory default.

Ignore changes and exit

Cancel any changes entered during the current session.
Then, exit and restart the computer.

Save changes and exit

Save any changes entered during the current session. Then,
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE:

Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Administrator Tools
Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management (requires a BIOS administrator password)
Create New BIOS User Account

●

Select from a list of BIOS users.

●

Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment

Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (if present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools
Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft
AT-p

Enable/disable Anti-Theft Protection.

DriveLock Passwords

●

Enable/disable DriveLock on any computer hard drive
(enabled by default).

●

Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.
Automatic DriveLock

Enable/disable Automatic DriveLock support.

TPM Embedded Security

Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.
NOTE: You must have a setup password to change this
setting.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.
CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE:

Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language

Change the Computer Setup language.

Boot Options

●

Set a Startup Menu delay (in seconds).

●

Set the Multiboot Express Boot Popup delay (in
seconds).

●

Enable/disable Custom Logo (disabled by default).

●

Enable/disable Display Diagnostic URL (enabled by
default).

●

Enable/disable CD-ROM boot (disabled by default).

●

Enable/disable SD Card boot (enabled by default).

●

Enable/disable floppy boot (enabled by default).

●

Enable/disable PXE Internal NIC boot (enabled by
default).

●

Enable/Disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

●

Set the Legacy Boot Order.

●

Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

Device Configurations
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◦

Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running.

◦

Startup from bootable USB devices, including a
hard drive or optical drive connected by a USB port
to the computer.

●

Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

●

Enable/disable fan always on while connected to an AC
outlet (enabled by default).

●

Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

●

SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:
◦

AHCI (Advanced Host Controller Interface)

◦

IDE (Integrated Drive Electronics)

Select

To do this
NOTE:
model.

Availability of these options varies by computer

●

Enable/disable secondary battery fast charge (enabled
by default).

●

Enable/disable HP QuickLook (enabled by default).

●

Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

●

Enable/disable HP QuickWeb (enabled by default).

●

Enable/disable HP QuickWeb: Write Protect (disabled
by default).

●

Enable/disable Virtualization Technology (select models
only; disabled by default).

●

Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

●

Multi Core CPU (enabled by default).

●

Intel HT Technology (enabled by default).

●

Enable/disable Wake on USB (enabled by default).

●

Enable/disable Num lock state at boot (disabled by
default).
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Select

To do this

Built-In Device Options

●

Enable/disable the wireless button state (enabled by
default).

●

Enable/disable embedded WLAN device radio (select
models only; enabled by default).

●

Enable/disable the embedded Bluetooth device radio
(enabled by default).

●

Enable/disable the Network Interface Controller (NIC)
(enabled by default).

●

Enable/disable LAN/WLAN switching (disabled by
default).

●

Set the wake on LAN state. Options include the
following:
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◦

Disabled

◦

Boot to Network

◦

Follow Boot Order

●

Enable/disable the Ambient Light Sensor.

●

Enable/disable the Notebook Upgrade Bay device
(enabled by default).

●

Enable/disable the fingerprint device (enabled by
default).

●

Enable/disable the integrated camera (enabled by
default).

●

Enable/disable the Power Monitor Circuit (enabled by
default).

●

Enable/disable the audio device (enabled by default).

●

Enable/disable a modem device (enabled by default).

●

Enable/disable the microphone (enabled by default).

●

Enable/disable the internal speakers (enabled by
default).

Select

To do this

Port Options

NOTE:

All port options are enabled by default.

●

Enable/disable the serial port.

●

Enable/disable the parallel port.

●

Enable/disable the flash media reader.

●

Enable/disable the USB port.
CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

AMT Options

●

Enable/disable the 1394 port.

●

Enable/disable the ExpressCard slot.

●

Enable/disable the Smart Card reader slot.

●

Enable/disable the eSATA port.

●

Enable/disable Firmware Verbosity.

●

Enable/disable AMT Setup Prompt (Ctrl+P).

●

Enable/disable USB Key Provisioning Support.

●

Enable/disable Unconfigure AMT on next boot.

●

Select Terminal Emulation Mode.
◦

ANSI

◦

VT100

●

Enable/disable Firmware Progress Event Support.

●

Enable/disable Initiate Intel CIRA.

Set Security Level

Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults

Restore the default security settings.
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Specifications

Computer specifications
Metric

U.S.

Length

22.0 cm

8.7 in

Width

32.2 cm

12.7 in

Height (front to rear)

3.4 to 3.6 cm

1.32 to 1.41 in

Weight (equipped with 33.8-cm (13.3-in) HD display, DVD
drive, 1-GB DIMM, 250-GB hard drive, 3-cell battery)

1.95kg

4.30 lbs

Dimensions

Input power
Operating voltage

18.5 V dc @ 3.5 A – 65 W

Operating current

3.5 A

Temperature
Operating (not writing to optical disc)

0°C to 35°C

32°F to 95°F

Operating (writing to optical disc)

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia)

-15 m to 3,048 m

50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia)

-15 m to 12,192 m

-50 ft to 40,000 ft

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating
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0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Metric
Nonoperating

U.S.

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

33.8-cm (13.3-in) HD display specifications
Metric

U.S.

Height

21.0 cm

8.25 in

Width

35.9 cm

14.15 in

Diagonal

33.8 cm

13.3 in

Surface treatment

Anti-glare

Contrast ratio

300:1 (typical)

Refresh rate

60 Hz

Brightness

200 nits (typical)

Dimensions

Pixel resolution
Pitch

0.252 mm

Format

1366 × 768

Configuration

RGB stripe

Backlight

LED

PPI

101 ppi

Viewing angle

+/-30 horizontal (minimum), +/–10° vertical (minimum)
30/30/20/10 (Left/Right/Down/Up) (minimum) or
45/45/35/25 (Left/Right/Down/Up) (typical)
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Hard drive specifications
750-GB*

500-GB*

320-GB*

250-GB*

Height

9.5 mm

9.5 mm

9.5 mm

9.5 mm

Width

70 mm

70 mm

70 mm

70 mm

Weight

101 g

101 g

101 g

101 g

Interface type

SATA

SATA

SATA

SATA

Transfer rate

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

ATA security

Dimensions

Seek times (typical read, including setting)
Single track

3 ms

3 ms

3 ms

3 ms

Average

13 ms

13 ms

13 ms

13 ms

Maximum

24 ms

24 ms

24 ms

24 ms

Logical blocks

1,572,864,000

1,048,576,000

625,141,400

488,397,168

Disc rotational speed

7200 rpm

7200 rpm

7200 rpm

7200 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW SuperMulti DL LightScribe Drive specifications
Applicable disc

Center hole diameter

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CDROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVDROM (DVD-5, DVD-9, DVD-10, DVD-18), DVDR, DVD-RW, DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW
DVD+R, DVD+RW, DVD-R, DVDRW, DVD-RAM

1.5 cm (0.59 in)

Disc diameter
Standard disc

12 cm (4.72 in)

Mini disc

8 cm (3.15 in)

Disc thickness

1.2 mm (0.047 in)

Track pitch

0.74 µm

Access time

CD

DVD

Random

< 175 ms

< 230 ms

Full stroke

< 285 ms

< 335 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

2 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD-ROM

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

< 15 seconds

Stop time

< 6 seconds
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Blu-ray ROM DVD±RW SuperMulti DL LightScribe Drive
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HDROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time

CD

DVD

HD

Random

170 ms

170 ms

230 ms

Cache buffer

8 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

1X BD-ROM

4,500 KB/sec

1X BD-R read

4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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DVD-ROM Drive specifications
Applicable disc

DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital
Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter

1.5 cm (0.59 in)

Disc diameter
Standard disc

12 cm (4.72 in)

Mini disc

8 cm (3.15 in)

Disc thickness

1.2 mm (0.047 in)

Track pitch

0.74 µm

Access time

CD

DVD

Random

< 100 ms

< 125 ms

Full stroke

< 175 ms

< 225 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

512 KB

Data transfer rate
CD-R (24X)

3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X)

1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X)

3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X)

10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2

16.6 MB/s

Startup time

< 10 seconds

Stop time

< 3 seconds
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Specification information in Device Manager
Device Manager allows you to view and control the hardware attached to the computer, as well as
provides hardware specification information.
You can also add hardware or modify device configurations using Device Manager.
NOTE: Windows 7 and Windows Vista include the User Account Control feature to improve the
security of your computer. You may be prompted for your permission or password for tasks such as
installing software, running utilities, or changing Windows settings. Refer to Windows Help and
Support for more information.
After you open Device Manager, drill-down to a device and double-click it to access its properties.
To access Device Manager in Windows 7:
1.

Select Start > Computer > System properties.

2.

In the left pane, click Device Manager.

To access Device Manager in Windows Vista:
1.

Select Start > Computer > System properties.

2.

In the left pane, click Device Manager.

To access Device Manager in Windows XP:
1.

Select Start > My Computer.

2.

In the left pane of the System Tasks window, select View system information.

3.

Select Hardware tab > Device Manager.
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Backup and recovery

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.
Windows Backup and Restore provides the following options:
●

Creating a system repair disc (select models only)

●

Backing up individual files and folders

●

Creating a system image (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4.
●

Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support
for more information.
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Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.
To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition and the HP Recovery partition.
To check for the Windows partition, select Start > Computer.
To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.
NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3.

If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.
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NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)
If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows 7 operating system
DVD, go to http://www.hp.com/support, select your country or region, and then follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD, follow these steps:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.
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6.

Select Repair your computer.

7.

Follow the on-screen instructions.

Windows Vista
To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.
The Backup and Restore Center provides the following options:
●

Backing up individual files and folders

●

Backing up the entire hard drive (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents folder, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste.
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The screen image is added to the document.
4.
●

Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore Center.

2.

Follow the on-screen instructions to back up your entire computer (select models only) or your
files.
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support
for more information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Select Start > All Programs > Maintenance > Backup and Restore Center.

2.

Follow the on-screen instructions to recover your entire computer (select models only) or your
files.
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NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.
To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.
NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3.

Restart the computer, and then press f8 before the Windows operating system loads.

4.

Select Repair your computer.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.
NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.

3.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.
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Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and then
follow the on-screen instructions. You can also order the DVD by calling technical support. For
contact information, refer to the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows Vista operating system DVD, follow these steps:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.

Windows XP
To protect your information, use the Windows Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore
your computer.
Windows provides the following options:
●

Backing up individual files and folders

●

Backing up all files and folders

●

Scheduling automatic backups

●

Creating recovery points

●

Recovering information

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:
●

Store personal files in the My Documents folder, and back it up periodically.

●

Back up templates stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.
To copy the screen and paste it into a word-processing document:
a.

Display the screen you want to save.

b.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c.

Open a word-processing document, click Edit > Paste.
The screen image is added to the document.

d.

Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Accessories > System Tools > Backup.

2.

Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

●

Operating System and Driver Recovery discs (included with your computer): You can use the
discs to recover your operating system and programs installed at the factory.
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Recovering your information
To recover information you previously backed up, follow these steps:
1.

If possible, back up all personal files.

2.

Select Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.

3.

Click Restore files and settings, and then click Next.

4.

Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.
To recover your operating system and programs, follow these steps:
1.

If possible, back up all personal files.

2.

Insert the Operating System disc into the optical drive.

3.

Shut down the computer.

4.

Turn on the computer.

5.

Follow the on-screen instructions to install the operating system.

6.

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7.

Follow the on-screen instructions to install the drivers and programs.
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8

Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

CCC

5

South Korea

EK

4

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the LCD panel and the backlight. When you remove
these components, handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.
This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel (3).
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4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside-down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 port, identifying

17

A
AC adapter, spare part numbers
33, 36
AMT options 111
AMT Setup Prompt (Ctrl-P)
111
Firmware Progress Event
Support 111
Firmware Verbosity 111
Initiate Intel CIRA 111
Terminal Emulation Mode 111
Unconfigure AMT on next
boot 111
USB Key Provisioning
Support 111
antennas 19
disconnecting 54, 68
WLAN 19
WWAN 19
Anti Theft 107
applications key, Windows 14
audio, product description 3
audio-in (microphone) jack
identifying 17
audio-out (headphone) jack
identifying 17
B
backing up files 119
Backup and Restore 119, 120
Backup and Restore Center 123,
124
base enclosure
illustrated 29
removal 79
spare part number 27, 37, 79

battery
removal 49
spare part number 26, 49
battery bay 18
battery light 15
battery release latch 18
BIOS administrator password
107
Blu-ray ROM DVD±RW SuperMulti
DL LightScribe Drive
removal 56
spare part number 26, 32, 40,
56
Bluetooth cable, illustrated 30
Bluetooth module
removal 62
spare part number 27, 35, 62
boot options 108
boot order 108
Bottom cover
illustrated 29
removal 51
spare part number 27, 51
Bottom cover release latch 18
built-in device
Ambient Light Sensor 110
audio device 110
Bluetooth device radio 110
fingerprint reader 110
integrated camera 110
internal speakers 110
LAN/WLAN switching 110
microphone 110
modem 110
Network Interface Controller
(LAN) 110
Notebook Upgrade Bay 110
Power Monitor Circuit 110
Wake on LAN 110

wireless button 110
WLAN device radio 110
built-in device options 110
buttons
left pointing stick button 10
left TouchPad 10
power 12
QuickWeb 13
right pointing stick button 10
right TouchPad 10
TouchPad 12
TouchPad on/off 10
volume mute 13
wireless 12
C
Cable Kit
contents 30
spare part number 27, 30, 38
cables, service considerations 43
caps lock light, identifying 11
chipset, product description 1
components
bottom 18
display 8
front 15
left-side 16
rear 17
right-side 17
top 10
computer feet
locations 48
spare part number 48
Computer Setup
File menu 106
navigating and selecting 104
restoring factory settings 105
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Security menu 107
System Configuration menu
108
computer specifications 112
connector, power 17
connectors, service
considerations 43
creating a backup 119
D
device configurations 108
discs
Driver Recovery 127
Operating System 127, 128
disk sanitizer 107
display assembly
removal 84
spare part numbers 22, 84
display bezel
removal 87
spare part numbers 28, 38, 88
display component recycling 131
display components, spare part
numbers 28
display hinge
removal 89
spare part number 28, 91
display hinge kit
spare part number 38
display panel
product description 1
removal 89
Display Panel Support Kit, spare
part number 29, 41
display panel, spare part number
29, 40
display release latch, identifying
15
display specifications 113
DisplayPort, identifying 17
docking support, product
description 4
drive light 15
DriveLock
automatic 107
password 107
Driver Recovery disc 127
drives
boot order 108
preventing damage 43
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DVD-ROM Drive
precautions 43
removal 56
spare part number 26, 32, 40,
56
specifications 117
DVD±RW SuperMulti DL
LightScribe Drive
precautions 43
removal 56
spare part number 26, 32, 40,
56
E
eject button
optical drive 16
electrostatic discharge 44
eSATA port, identifying 17
esc key, identifying 14
Ethernet, product description 3
Execution Disable 108
expansion memory module
removal 63
spare part numbers 63
ExpressCard assembly
removal 99
spare part number 40, 99
ExpressCard cable, illustrated 30
ExpressCard slot, identifying 16
external media cards, product
description 4
external monitor port
identifying 17
F
f11 recovery 122, 125
fan
removal 74
spare part number 24, 38, 74
feet
locations 48
spare part number 48
File menu 106
Fingerprint reader board
removal 98
spare part number 27, 41, 98
fingerprint reader, identifying 13
fn key, identifying 14
function keys, identifying 14

G
graphics, product description
grounding equipment and
methods 46

1

H
hard drive
precautions 43
product description 2
removal 60
spare part number 40
spare part numbers 27, 32,
37, 60
specifications 114
hard drive bracket, removal 61
hard drive recovery 122, 125
HDD Hardware Kit
spare part number 41
headphone (audio-out) jack
identifying 17
heat sink
removal 75
spare part number 24, 41, 75
hinge
removal 89
spare part number 28, 38, 91
Hinge Kit
contents 31
spare part number 31
HP QuickLook 109
HP QuickWeb light 11
HP SpareKey enrollment 107
I
IEEE 1394 port, identifying 17
integrated webcam light,
identifying 9
Intel HT Technology 109
internal display switch 8
internal microphones, identifying
8
J
jacks
audio-in (microphone) 17
audio-out (headphone) 17
RJ-11 (modem) 17
RJ-45 (network) 16

K
keyboard
product description 4
removal 65
spare part numbers 22, 38,
39, 65
keypad keys, identifying 14
keys
esc 14
fn 14
function 14
keypad 14
num lk 14
Windows applications 14
Windows logo 14
L
language, changing in Computer
Setup 108
latch
display release 15
latch, battery release 18
latch, Bottom cover release 18
Left hinge assembly, illustrated
31
legacy support, USB 104, 108
lights
battery 15
caps lock 11
drive 15
HP QuickWeb 11
local area network (LAN) 15
mute 11
num lock 11
power 11, 15
webcam 9
wireless 11, 15
M
mass storage devices, spare part
numbers 32
Media Card Reader, identifying
15
memory module
product description 2
removal 63, 72
spare part number 72
spare part numbers 27, 63

microphone (audio-in) jack
identifying 17
product description 3
microphone board
spare part numbers 40
model name 1
modem module
product description 3
removal 70
spare part number 24, 37, 70
monitor port
external 17
Multi Core CPU 109
mute light, identifying 11
N
num lk key, identifying
num lock light 11

14

O
Operating System disc 127, 128
operating system, product
description 5
optical drive
precautions 43
product description 2
removal 56
spare part numbers 26, 32, 56
specifications 115, 116, 117
optical drive eject button
identifying 16
P
packing guidelines 45
parallel port mode 108
passwords 107
plastic parts 42
Plastics Kit
contents 29
spare part number 29, 40
pointing device, product
description 4
pointing stick 10
port options 111
1394 port 111
eSATA port 111
ExpressCard slot 111
flash media reader 111
parallel port 111
serial port 111

Smart Card reader slot 111
USB port 111
ports
1394 17
DisplayPort 17
eSATA 17
external monitor 17
product description 4
USB 16, 17
Power button board
removal 95
spare part number 26, 40, 95
power button, identifying 12
power connector cable
illustrated 30
removal 102
spare part numbers 102
power connector, identifying 17
power cord
set requirements 129
spare part numbers 33, 35
power light 11
power lights, identifying 15
power requirements, product
description 4
primary memory module
removal 72
spare part number 72
processor
product description 1
removal 77
spare part numbers 24, 77
product description
audio 3
chipset 1
display panel 1
docking support 4
Ethernet 3
external media cards 4
graphics 1
hard drives 2
keyboard 4
memory module 2
microphone 3
modem module 3
operating system 5
optical drives 2
pointing devices 4
ports 4
power requirements 4
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processors 1
product name 1
security 5
serviceability 6
webcam 3
wireless 3
product name 1
Q
QuickWeb button, identifying 13
R
recovery partition 122, 125
release latch, battery 18
release latch, Bottom cover 18
removal/replacement
preliminaries 42
procedures 47
restore security defaults 111
restore the factory settings 106
restoring
hard drive 122, 125
Right hinge, illustrated 31
RJ-11 (modem) jack
identifying 17
RJ-11 connector cable
illustrated 30
removal 100
RJ-45 (network) jack
identifying 16
RTC battery
removal 94
spare part number 26, 41, 94
Rubber Kit, spare part number 40
S
SATA (Serial Advanced
Technology Attachment)
devices 108
AHCI (Advanced Host
Controller Interface) 108
IDE (Integrated Drive
Electronics) 108
Screw Kit, spare part number 34,
40
Secondary Battery Fast Charge
109
security cable slot, identifying 16
Security menu 107
always prompt for HP
SpareKey enrollment 107
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Automatic DriveLock 107
change password 107
Disk Sanitizer 107
DriveLock 107
fingerprint reader reset 107
HP Sparekey 107
HP Sparekey enrollment 107
password policy 107
set up BIOS administrator
password 107
System IDs 107
security, product description 5
service considerations 42
service tag 20, 47
serviceability, product
description 6
set security level 111
setup utility
File menu 106
navigating and selecting 104
restoring factory settings 105
Security menu 107
System Configuration menu
108
SIM, removal 50
slots
ExpressCard 16
security cable 16
Smart Card reader
spare part number 41
solid-state drive, spare part
numbers 27, 32, 40, 60
speaker assembly
identifying 15
removal 82
spare part number 26, 40, 82
speaker kit
spare part number 82
specifications
Blu-ray ROM DVD±RW
SuperMulti DL LightScribe
Drive 116
computer 112
display 113
DVD-ROM Drive 117
DVD±RW SuperMulti DL
LightScribe Drive 115
hard drive 114
optical drive 115, 116, 117
static-shielding materials 46

system board
removal 91
spare part number 26
spare part numbers 40, 91
System Configuration menu 108
system date and time 106
system diagnostics 106
system fan 108
system IDs 107
system information 106
T
thermal material, replacement 76
tools required 42
top cover
spare part number 23
spare part numbers 40
TouchPad
buttons 10
TouchPad cable, illustrated 30
TouchPad on/off button
buttons 10
identifying 12
TouchPad, identifying 10
TPM Embedded Security 107
transporting guidelines 45
TXT (Intel Trusted Execution
Technology) 109
U
Unified Extensible Firmware
Interface (UEFI) mode 108
upgrade bay
identifying 16
removal 58
spare part number 58
Upgrade Bay, spare part number
41
USB legacy support 104, 108
USB ports, identifying 16, 17
User management 107
V
vents, identifying 17, 18
Virtualization Technology 109
volume mute button, identifying
13

W
webcam 9
product description 3
spare part number 40
webcam light, identifying 9
webcam, identifying 9
Windows 7 operating system
DVD 122
Windows applications key,
identifying 14
Windows Backup utility 126, 127
Windows logo key, identifying 14
Windows recovery 128
Windows Vista operating system
DVD 126
wireless antennas
disconnecting 54, 68
location 19
wireless antennas, identifying 8
wireless button, identifying 12
wireless light, identifying 15
wireless lights 11
wireless, product description 3
Wireless/web/mute function board
removal 96
spare part number 26, 96
spare part numbers 40
WLAN antennas, identifying 8,
19
WLAN module
removal 52
spare part number 35, 37, 52
spare part numbers 24
workstation guidelines 45
WWAN antennas, identifying 8,
19
WWAN module
removal 68
spare part number 27, 37, 68
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